Defects Resolved in Team Developer 3.0.00 (build 13284)
3.0.00 – Build 13284

Defect
Category
ID
73949
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ACTIVEX
CONTAINER
ACTIVEX
76001
CONTAINER
ACTIVEX
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CONTAINER
ACTIVEX
77014
CONTAINER
ACTIVEX
801021
CONTAINER
ACTIVEX
73771
LIBRARIES
ACTIVEX
76525
LIBRARIES
ACTIVEX
76836
LIBRARIES
ACTIVEX
77337
LIBRARIES
74718

76998

APP SERVER

77282

ATTRIBUTE
INSPECTOR

75997

BUILD
SETTINGS
CDK

75998

CDK

76657

CDK

74604

CHILD
WINDOWS

74147

Description
When inserting an ActiveX control using SalActiveXInsertObjectDlg()
with option Create from File it is not possible to retrieve in Centura the
name of the files used to insert the object
GPF on closing Insert Object Dialog in User mode
When multiple objects are inserted into container TD gpfs
Application GPFs at runtime when form with ActiveX container is closed.
GPF on exit after creating Outlook View ActiveX control
ActiveX GetLastError() function return an incorrect scode negative error
number.
When inserting an ActiveX control using SalActiveXInsertObjectDlg() it
is not possible to retreive in Centura the ProgID of the Object Inserted.
Excel object does not function correctly when all objects are contained in a
functional class
ActiveX objects that have an event described with an Object as a
parameter do not compile.
ActiveX Explorer incorrectly generates "int" numbers as VT_R8.
WAM is unable to satisfy more than 5 simultaneous requests for a given
service name.
When TD is started,even if the focus is on a window object in the left
frame and AI is enabled,nothing is displayed in the AI. Only when I click
again on the window object,AI is filled with properties of the window
object.
The "File Version" property in the Build Settings Dialog is not being set as
the files version resource on Win2K and XP.
CDKRegisterFactory is mentioned in help file but is not in CDK.H
"cdk.apl" CDKActionBlock does not correctly initialize member variables
in the First( ) function or in the Child( ) functions also overrides the
cdkItem.delete function for CDKActionBlock
NotificationInterface does not support more than one dll at a time.
A SqlHandle value will be overwritten with no apparent reason when
setting another class instance value. The two have nothing to do with each
other.

801009
74060
76652
73485
73793
74045
75927

CHILD
WINDOWS
COM CLASS
WIZARD
COM SERVER
GENERATION
COM/ACTIVEX
CLIENT
COM/ACTIVEX
CLIENT
COM/ACTIVEX
CLIENT
COM/ACTIVEX
CLIENT

77706

COMPILER

76027

DBEXPLORER
DESIGN-TIME
FEATURES

75556

76742

DESIGN-TIME
FEATURES

75479

DYNALIB

76747

EDIT MENU

76748

EDIT MENU

75337

EXTERNAL
FUNCTIONS

73167

FOCUS &
ACTIVATION

75983

GENERAL

76629

GENERAL

77030

GENERAL

77276

GENERAL

SalEditCopy( ) from selected data from a Child Table causes a GPF when
there is more than 64 kb.
Tab sequence confusing in Add Function dialog of COM Class Wizard
SalCompileAndEvaluate throws an error message when it is called with
string array parameter within a COM method. This doesn't happen if the
COM server is run in debug mode.
ActiveX events with integer parameters are seen as real numbers by
CTD2000.
"bOK = SalActiveXAutoErrorMode( bOn )" function returns a Numeric
number greater than 1.
CTD crashes when trying to call an Event with a 3rd Party non-visual
control
Memory leak / performance degradation with each call to a COM event
handler
TD vanishes (sometimes GPFs) when tries to compile an application
having wrong parameters or wrong name or case mismatch for the
function of an object that is being invoked.
DBExplorer Define Query dialog tabs disappear when selected.
At design time only,External Library dll's are incorrectly being unloaded
from memory.
Only the dll that was specified under DesignHookDLL1 string value in the
registry gets loaded. All other Dll's under DesignHookDLLn (as specified
in the documentation where n represents the ordinal number of the dll)
never get loaded.
Under Japanse windows,when calling functions from dynalibs,TD gives
undefined function error at compilation time.
"Find" dialog does not enable "Find Next" button when an item is selected
with the combo box
"Replace" dialog does not enable "Find Next" or "Replace All" buttons
when an item is selected with the combo box
Migrating an app(from 1.5.1 to 2.1) that interfaces with an external dll to
clone,serialize,and recreate udvs causes assertion and memory leak when
run in debug mode(means ctd source is run in debug mode)
When using SQA Rational Robot and doing menu selects by id,an item
that is supposed to be unselectable can be selected.
SQL Windows closes when trying to map base class to another class,when
the name is not defined for the derived class.
A GPF occurs,when you use a german umlaut as accelerator in a tab.
When using a 2-dimensional numeric array as a parameter,when calling a
function with receive parameter the wrong array element will be
overwritten.
Trying to close or run an unmodified application prompts the user to save
changes in the file.

73487

INFORMIX

76849

MDI WINDOWS

73480

OBJECT
COMPILER

74736

OBJECT
COMPILER

74798

OBJECT
COMPILER

73565

OLE DB
CONNECTIVITY

75120
75127

OLE DB
CONNECTIVITY
OLE DB
CONNECTIVITY

75128

OLE DB
CONNECTIVITY

75388

OLE DB
CONNECTIVITY

75598

OLE DB
CONNECTIVITY

75902

OLE DB
CONNECTIVITY

76180

OLE DB
CONNECTIVITY

76382
76459
76760
77711
50249

SQLIFX32 CTD2000 PTF1 Cannot connect anymore to a non default
Informix Server,because defconnect is not reconized anymore and the
default is to use defconnect=on.
Memory space for the MDI variable gets freed before all the child
windows are destroyed. This is when the MDI windows is closed and
SAM_Destroy gets sent. This may induce Access violation when an
attempt to access variable is performed.
Object Compiler CTD2000 Linking error,CTD2000PTF1 Access
Violation in hpti20.exe when Object Compiling an Internal function that
sets a string ( sql stament ) containing TABS
Object compiling an apt which has a space at the end of line causes object
compiler to crash.
CTD2000/CTD 2.10 Access violation in hpti20.exe (NTDLL.DLL) when
compiling many internal functions that are dependant on each other. This
does not happen with CTD 1.51
When using ODBC syntax to call an Oracle stored procedure fails on the
SqlExecute. If using Oracle's OLE DB Provider an error ORA-06550
occurs. Microsoft's Oracle OLE DB Provider,returns an error zero.
Using OLE DB to call stored procedures, in Oracle, the bind values of the
SP parameters are truncated
Using Oracle OLE DB the string values in a bind variable in the where
clause gets truncated to two characters
Using Oracle OLE DB a numeric bind in a stored procedure call causes a
sql error to be thrown even though it looks like the values went through
and the SP executed
Using Oracle's Oracle OLE DB Provider,calling a stored procedure using
Oracle's Native Syntax fails with an error zero.
TD210 OLE DB CONSUMER against INFORMIX client Connect 2.70
with OLE DB provider v2.50.0.0; GPF in SQLExecute() when having
previously prepared successfully a simple stored procedure via
SqlPrepareSP() INFORMIX OLE DB
Attempting to insert data into DB2/NT from TD via IBM's OLE DB
Provider,the data inserted looks like Unicode,not the actual value entered.
Unable to use SqlGetSessionErrorInfo to report a failure to create the
session using SqlCreateSession call. Instead of allowing for the user to
trap this,a "Halt Application" error occurs instead.
Huge memory leaks with ctd COM server talking to Oracle via OLE DB
and vb com client.
Memory leak in OLE DB consumer code in TD when using string input
binds with Microsoft SQL Server provider.
TD does not support OS authentication when connecting to Oracle via
OLE DB.

OLE DB
CONNECTIVITY
OLE DB
CONNECTIVITY
OLE DB
CONNECTIVITY
OLE DB
SalListPopulate() fails with SqlServer OLE DB
CONNECTIVITY
ON-LINE HELP VisListGetFlags does not appear in the on-line Visual Toolchest help

60810
67295

ON-LINE HELP
ON-LINE HELP

70820

ON-LINE HELP

71383

ON-LINE HELP

72443

ON-LINE HELP

72781

ON-LINE HELP

73000

ON-LINE HELP

73033

ON-LINE HELP

73034

ON-LINE HELP

73311

ON-LINE HELP

73463

ON-LINE HELP

74003

ON-LINE HELP

74127

ON-LINE HELP

74130

ON-LINE HELP

74584

ON-LINE HELP

74777

ON-LINE HELP

74832

ON-LINE HELP

75444

ON-LINE HELP

76449

ON-LINE HELP

The return value of cOutlineListBox.LoadOutlineFile is wrong.
Report Builder in a box - No help for Properties dialog field tab
The Online books installation prompts the user to install Adobe Acrobat
version 3.0. Instead,it installs version 4.0
"SalObjIsNull" function is not present in list of system functions,but has
two entries in index.
Need to document the fact the Result set mode is ON by default when
connecting to SqlBase from a CTD app.
Boolean input parameter for SalMTSIsCallerInRole function, should be
Receive Boolean.
Choosing Quick Object from Help menu a message appears "Help doesn't
exist"
COM Class Wizard - CoClass Help screen calls entries in first COM
wizard dialog "COM server" and "MTX server." Should be "CoClass" and
"MTS CoClass"
COM wizard - Help screen for Add Argument dialog says user can specify
whether argument is to be an array - Not true
Maximum table window cache size is 2,147,423,632 rows; in the help file
it still shows the old value 32,767
The book shows Samples directory instead of Centura when user wants to
save a new application.
Need to document the following cdk additions to the cdkContainer class in
the Books online & help file. ! ! Named Menu functions Function:
AddNamedMenu Function: RemoveNamedMenu Function:
GetNamedMenu Function: EnumNamedMenus Function:
EnumNamedMen
Help for QuickObject Editor is missing
In the "Tools\Preferences" dialog the Pressing the "Help" pushbutton
whilst on several tabs causes the error "The topic does not exist. Contact
your application vendor for an updated Help file.(129)"
Help for line border properties brings up field properties
This is a DOC enhancement. The function SalActiveXGetData() mention
correctly that it returns row blobs of bytes but does not mention that it is
no point or invalid to set it into Datafield of type long string or in table
windows column.
SalDateConstruct does not document valid range for year. Year 0000 is
not a valid year. Other parameters for function have valid ranges
documented.
All functions relating to the OLE DB consumer are missing from the
online help
In the dev.pdf on page 18-3,it states: "You must save an include library as
a normal binary file. You cannot include items from an *.APL file that is
saved as text or indented text (*.APT)." This is not true.
Documentation for SalStrSetBufferLength says one byte is added for the

76642

ON-LINE HELP

null terminator, but this is incorrect.
No online help available for Text tab within Properties dialog for a Report
76716 ON-LINE HELP
Builder field.
Online Help for "SqlGetErrorPosition" is not updated completely. The
76738 ON-LINE HELP same problem is existing even in books online (funcref.pdf) for
"SqlGetErrorPosition" function.
Using TD210 OLE DB consumer on Error condition,one should allways
76887 ON-LINE HELP use SqlGetSessionErrorInfo() to get the proper error
Description,SqlGetErrorText() would not work
Help for the first parameter (Window handle) of
800411 ON-LINE HELP
SalContextMenuSetPopup is misleading.
76116 ORACLE8
sqlora32.dll from PTF1 GPF's when there's a row of select statements
Can only fetch back 2000 characters from a VARCHAR2 column in
76476 ORACLE8
Oracle.
75296 PICTURES
JPEG's are not properly displayed when the display is set to True Color.
When SalPrtPrintForm(hWndForm) containing a cDriveComboBox, the
800532 PRINTING
cDriveComboBox is not being printed.
SalPrtSetup does not save any of the changes you make. In
800798 PRINTING
particular,paper orientation changes are ignored.
CTD 1.51 cQuickFTP,ConnectProxy() GPF in Wininet.dll,normal
71687 QUICKOBJECTS
Connect() works fine.
REPORT
Double-clicking a file named *.qrp,which is not internally a QRP format
57709
BUILDER
file will give a proper error message and then will crash with a page fault.
When using SalReportView to Call a report,and setting hWndRepttemp to
REPORT
60948
be the Form which calls the report results in some objects of the form
BUILDER
being visible through the Report
REPORT
Passing STRING_Null as the fourth parameter to SalReportDLGOptions
63136
BUILDER
will cause a GPF.
MIGRATION -- A combination of column breaks and page breaks on
REPORT
different lines in the Detail Block,along with totals that reset on page
63319
break leads to unexpected results in Report Builder -- but works as
BUILDER
expected in ReportWriter 3.0.2.
REPORT
63407
STRING_Null cause a GPF when used in SalReportView.
BUILDER
REPORT
Using the COLBREAK causes a second page to be created and the Report
67054
BUILDER
footer information to be listed there. This happens in CTD1.5 PTF2 also.
REPORT
On changing the settings to and from landscape to Potrait,there is a
67560
BUILDER
spurious behaviour in the report view on the screen.
When a BMP sent to the report builder image container or a BMP is
REPORT
directly past into this image container,and the BMP is bigger than the
68134
BUILDER
container with the option scale being correctly set,the container displays it
incorrectly.
REPORT
Report builder does not work properly with the orientation setting in
68483
BUILDER
report.
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REPORT
BUILDER

73248

REPORT
BUILDER
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74780
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76896
77032
77295
77450
77456
77463
77612
77666
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73654

74525

74817

REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER
REPORT
BUILDER

Formulas are created for each object added in a report. Customer feels this
is unnecessary,particularly if they are not being used. This affects
development performance badly compared to ctd112 report builder.
The picture is not displayed in a rtf file (picture in the page header of the
QRP) when created with the function SalReportPrintToFile in the version
CTD151 PTF4
The Version tab in Properties for repbi21.exe is incorrect.
When using a breakgroup,lines that should show up after the page break
only show up for the first record
If SalReportPrintToFile is called to write the report, created using activex
calls, to an rtf file the font appearance is not the same as SalReportView.
When more than one report printed within a loop,some pages or some
reports all together are missing.
"Custom Page Size" reports don't print correctly in Win2K environment.
Report Builder should be able to accept Database name,User Name and
Password as arguments.
SalReportView will print a .qrp in PORTRAIT,although it was constructed
to print LANDSCAPE. Same with SalReportPrint.
Report Builder: wrong tabs presented to user after choosing Format>Colors or Format->Borders
Report Builder: Keyboard "Delete" key doesn't work for a background text
Wrong property dialog is invoked when Format->Borders is selected for
background text and Field.
Report Builder prints blank pages when printing to HP4100 with report
format A4
Pictures get clipped in report builder when report is resized.

When using SalReportView with custom report template (second
SAL FEATURES parameter) the focus does not return to the formwindow from which it is
called. Same bug exists with CTD 2000.
CTD 2000 PTF2/PTF3 : Access Violation (READ) at exit both in runtime
and design time when allocating dynamically functional class using NEW
SAL FEATURES
into a static or dynamic array that is an instance variable. The number of
objects and methods is relevant in reproducing the problem.
Multiple inheritance problem. Instance variable loses value depending on
SAL FEATURES the order in which the derived from objects are listed. Code worked in
1.5.1
Using an instance variable of a functional class (which is instantiated as an
SAL FEATURES array) as a receive parameter to a function causes "reference to null user
defined variable" error. Worked in CTD 1.1.2
UDV instance variable passed as a Recieve parameter causes a "Reference

76318
76839
76564
76711
76864
77159
77271
77455
74529
74216
76658
76966
77300
77303
71293
71373
75159
75815
76539

69203

to Null user defined variable error" when accessed after return from
function.
TD 2000/210,Runtime property Reject Multiple Window Instances does
SAL FEATURES
not work at runtime but do work at design time
When the printer port has spaces,SalPrintSetup is parsing it for spaces,at
SAL
which point it thinks that there are additional printers with each space that
FUNCTIONS
it finds.
SAL
SalUseRegistry defaults to "CenturaApp" if no company name is given
FUNCTIONS
SAL
SalMTSCreateInstance() always fails.
FUNCTIONS
Object Destructor: The base class is able to call a function which is
SAL
implemented in the derived class,even though the derived class has been
FUNCTIONS
destroyed by its object destructor.
SAL
Incorrect value is returned by function "SalTblColumnSum"
FUNCTIONS
SAL
SalActiveXAutoErrorMode function's return value is inconsistent with
FUNCTIONS
other Sal functions
SAMPLE FILES Sample app CDKRunT.app will not compile
The file cstructl.apl should be installed into the main installation directory
SETUP
not the samples directory.
When running the Runtime Installer,there should be the option of
SETUP
including the deploy directory in the path.
SqlOpen used to perform Positoned Updates de-allocates memory
SQL ACCESS
prematurely. When SqlClose is called the cursor isn't available.
SqlSetParameter function returns true first time it is executed,on
SQL ACCESS
successive calls it returns false with OracleOLE DB provider.
SqlFreeSession function commits transaction even after AutoCommit is
SQL ACCESS
set to false.
Table column with popup edit cell type. If you open the popup and then
TABLE
scroll down or horizontally the popup box does not close, it falls off the
WINDOWS
screen.
TABLE
The application causes a Dr.Watson error on exit after SalTblCopyRows
WINDOWS
fails to copy more than 64K.
Clicking on column header to sort the column of a table with locked
TABLE
columns makes a column title appear in the row header portion of the table
WINDOWS
(at the intersection of row header and column header).
TABLE
Application migrated from SQLWindows 16bit to ctd2.1 ptf1 produces
WINDOWS
GPFs.
SalTblPopulate doesn't populate any column data in a table window using
TABLE
fully qualified columns. The problem only happens with an exe. If the app
WINDOWS
is run as an app from IDE then it works.
SAL FEATURES

TOM

Upgrading an existing TOM repository on Oracle 8 fails; The
compatibility and modification level upgrades don't seem to take effect

and it is requested by TOM to repeat it over and over again;
Only when using Sybase 12.5 client,an insert or update with a bind
variable is set to NUMBER_Null will result in a GPF.

76537

TOM

75925

TOP-LEVEL
WINDOWS

77336

Application interfacing with ADO has problem if an array of a UDV
USER DEFINED
(derived from Object class) is used. No problems if a single variable is
VARIABLES
used.

Top level windows do not paint correctly in Windows XP

